Setting Up A Classroom Blog with Edublogs.org
This guide will cover a small portion of setting up and using a blog site for free through the
Edublogs.org website. There are many advanced options and tweaks available to a blogger,
but we only have a limited amount of time to create and learn to use our own. Since
Edublogs.org and Learnerblogs.org are using the WordPress blog engine, this workshop will
use the name WordPress whether specifically speaking of WordPress, Edublogs, or
Learnerblogs directly.

Web Browser
You browser is the software you use to view web pages. For a long time, Internet Explorer
was the standard used by most computer users. While it still works fairly well on Windows,
it is no longer maintained for the Macintosh. A very good alternative to both computer
platforms (Mac and Windows) is the FireFox web browser. To get full use of all features on
most blogs, it is suggested that the user download and use the free FireFox web browser.
(Download at www.mozilla.com) Safari is a wonderful browser, but there have been a
number of blog features with Edublogs that are unavailable if you are using Safari.

Edublogs.org
This training is using the free subscription to edublogs.org. It is based
on the WordPress blog engine, but had been customized for educators.
You only need to give them a working email address and create an
account to get started. Go to http://edublogs.org, select ‘Join’ or ‘Get a blog now’, and click
to create a new account.
First, you will need to create your username. This
has to be unique and will be the username that your
students will see with your posts and comments.
Use and email address that you can check now. You
can always change that address later. You will
select ‘Create your blog’ and then click Next. Some
users only wish to have a ‘Just username’ so they
can leave comments on other blogs, but they don’t
wish to maintain their own.
(Some ideas passed around mention that you can
have your community of users each create their own
username without having to create a blog. It is one
way to protect the blog from unwanted users by
allowing only invited usernames registered with
Edublogs.)
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Next, you need to create your domain (website address) name. It can be different from your
user name or it can be the same. It must however be a unique name within the edublog
system. The name you choose will be the first part of the website address your students or
parents will enter to access your blog. “Hot Teacher” probably wouldn’t go over well with
the principal, so choose wisely. Second, you will give your blog a title. This will be the
name shown at the top of your browser’s window and does not have to be unique. One can
limit random visitors by keeping the blog private and not listing your blog with search
engines. Checking that box could cause problems if you want parents or others to see your
work. Lastly, select ‘Teacher’ as your blog type.

Activate the account by clicking
‘Signup’. You will get an email
that will give you a link to follow.
The resulting email will give you
your password needed to
administer the blog. Do not loose
the password. Do not give it to
students. Do not pass ‘Go’ or
collect $200.
Check your email now.
Setup Notes For Your Records:
Email address used: _______________________________________
Domain used (###.edublogs.org) : ____________________________
Username used: _______________________________
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As soon as you check your email, you will have a randomly-generated password to access
your ‘dashboard’. Only you have access to the dashboard since it is the main ‘control
center’. There are two ways to get into your dashboard. The first is after you login, you
enter the dashboard automatically. The second, and easier, way is to
use the ‘Site Admin’ link on your blog home page listed under your
Meta links. The Meta links are one of the widgets provided by
Edublogs. If you remove this widget when you choose to customize
your blog, you will lose the easy access to your dashboard.
Your dashboard will have a number of sections to
amaze and confuse you. We’re going to start by
looking at two of the links in this section; Update
Your Profile and Write a Post.

Update Your Profile
The first thing we’ll do is change our password.
Clicking ‘Update your profile’ lets us personalize
the blog user settings. That link also shows you your
contact info in case you want to change the contact
email address later. Anything you put in your profile
could be seen by visitors. You can change your password at the very bottom. After making
any changes to your profile, click ‘Update Profile’ at the very bottom of the page.

Write A Post
Clicking the ‘Write’ tab on the dashboard gets you started on your first post.
We are going to make a simple post for our students to read and respond to.
1. First, give the post a title. This not only gives a framework for the post,
but is also a nice reference.
2. Click inside the ‘Post’ box and start typing meaningful and thoughtful
text that will provoke students to respond in a similar deep manner. You
have 30 seconds. Go! One has as much room as needed. A scroll bar
will appear as your text gets close to the bottom of the window. It is suggested that for
your longer posts, type first in a word processor, copy and paste it into this box.
3.When you are done, ‘Save’ will save the post as a draft and exit the
new post window without putting your writing online; ‘Publish’
assumes you have finished and want the post shown on the blog.
Drafts are not visible until they are published.
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Viewing Your Page
The ‘Visit Site’ button is at the top of your dashboard window. Edublogs sets up
the blog with a default theme. Clicking this link will show you what your page
looks like. You can change almost any of the visual aspects of the page that you
see at first by going back into your dashboard.

Navigating Your Edublogs Blog

Edit Posts
From the dashboard, select the ‘Manage’ tab and then the ‘Posts’ tab
when it appears. This window will show you the posts that you have
saved on your blog. To edit one, click the ‘edit’ link to the right of the
post you wish to edit. This takes you to the ‘Write Post’ window that you used to create the
post initially.

Categories
One can live without categories, but if your blog grows through frequent use, then categories
can be a life-improver. Possible uses:
• label post by curriculum area if used in self-contained room
• label post by period or class
• label post as ‘test’ for review information that could be covered on a test
• label as genre of literature, style of written response requested, etc
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Whether you do this when you are creating a new post or by editing previously created
posts, adding a category is the same. First, get to the ‘Write Post’ window as discussed
above.
Scroll to the bottom of the window
to see the Categories section. Click
‘Add New Category’ to create a
new category of your choosing.
Select the checkbox next to a category that you’ve already made. You can use multiple
categories with one post. All posts will be uncategorized until you create your own.
Alternatively, one can manage categories from the dashboard. Click
‘Manage’ and then ‘Categories’ and you’ll be able to create, edit, or
delete categories for your blog.
Once categorized, a user can click that category on the front page to show matching results.
For example, a student wants to view posts that were marked as test review material. By
clicking the ‘Tests’ category, that student can remove all non-matching posts from sight.

Create a Page
Pages are different from posts in that they do not contain chronologically-organized posts. In
the classroom, this hold good promise in that procedures, teacher notes, or other static
information can be placed here. Pages are linked to from your blog’s home page.
Go to the dashboard and select the ‘Write’ tab and the ‘Page’ tab afterward. Give the page a
title. This title will be shown on your homepage. Next, type your information in the ‘page
content’ box.
Options for pages vary. Since pages are listed on your home page,
you could organize pages by giving specific topics. Pages can have
sub-pages on listed on your home page. That means, you could
create a ‘main’ (called a parent) page called rules. This main page
would give some general rule information. A second page could be
created for blogging rules and you could select the ‘main’ page as
the parent. The figure to the right shows three pages that have
Rules and Procedures as their parent.

EdublogSetup.doc

page 5

created by Hmartin@austinisd.org

Changing the Look
The Design tab in the dashboard
lets you change the look and
feel of the blog. The default Theme here is
a three column design with links, archives,
categories, and more listed on either side of
the blog posts that go down the middle.
By clicking the Design tab in the dashboard
and clicking the Themes tab under that, you
have the opportunity to choose a new theme.
Each theme is different in its look and
contents. Clicking any of the themes will automatically change your blog design. Click the
‘Visit Site’ button to see your new design.
Each theme has a default set of Widgets. Widgets add special functionality to your blog
page. Some widgets can add a calendar, a special link to social networking sites, a text block
where you can type whatever you want, etc. Warning: When you add widgets the first time
to your sidebars, they replace the default set already there. If you add any widget, you will
also have to add the ones that were already on the page, if you still want them.

The Surmountable Downside- Commenting
One of the great things about WordPress and Edublogs is that you can set it to mandate the
entry of identifiable information in order to leave a comment. The main identification can
be a required email address or Edublogs username. Since students don’t generally have
email addresses yet, there are two workable solutions a teacher can utilize.

1. The First method is to first log out of Edublogs and go back to the main Edublogs.org
webpage. Follow the directions from page one in this handout, but this time click the ‘Just a
username’ button. Make this username for your students. You can create a user and
password that all students will use when they blog in class. Perhaps I would use
‘mrmartinsclassstudent’ as an login ID. The trainable fix for identifying students with their
work is that students must type their name or initials at the end of their comment. Otherwise,
nobody will know who left which comments.
The second part to that is setting the blog to mandate the Edublogs ID. Using the
Dashboard, select the Options menu and the General tab. By checking the box
‘Membership’, you are mandating that the only comments left will be left by Edublogs
registered users. A
problem with this
method is that you
are making any parent or sister class across the country also register a Edublogs account.
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2. The second method is a much tighter lock down for comments. This can be used in
conjunction with the first method to increase the security of posted comments. Using the
Edublogs ‘Moderation’ tool, one can filter out undesirable comments and keep strangers
from adding comments. We will set up the blog moderation tool in Edublogs so that once an
email account is accepted by the teacher, that account is automatically posted from then on.
The truly wonderful thing is that the email accounts do not have to be valid! Have students
sign their comment with anonymous-like initials, but everyone uses an assigned fake email
account. Fake email accounts mean that there is no actual email the students will use and
their personal information isn’t online anywhere. In the example below, I just used student
initials with a bogus @email.com domain. You could use any domain such as
@mrmartin.com, @class.email, or whatever. Each student should use a different fake email,
which will register in your Edublogs
dashboard, but not on the page viewed
by others. Once you approve an email,
that email address will be allowed to
post without moderation. Other comment
attempts will be stopped by the
moderation tool and wait to be approved
by the teacher.

The downside to Edublogs moderation is in the initial posting. The teacher will have to
approve each student. That would only happen once for each ‘fake email’ account used.
Another downside is that students who misspell their approved fake email will not see their
comment until approved; a point for typing accuracy.

Setting Options in Edublogs
To set any options, login to your Edublogs account and find your dashboard. If you have
more than one account, you will see it under the drop down menu.
Go to the Options tab and select Discussion. There are two settings that can really help
manage your classroom blog.
Email me whenever:
The email feature is nice
especially when the blog is not
used on a daily basis. Emailing
comments that are held for
moderation will alert you to either
outsiders trying to comment or the
student who mistyped their fake
email address and isn’t recognized
by your moderation filter.
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Before a comment appears:
Some teachers want to approve every comment, which is what the first option shows. I
firmly believe that in a collaborative classroom environment, delaying all comments will
only slow the process, take away student-perceived ownership, and take away from the high
level of student interest in immediate interaction. But there are times that this may be
necessary. You will want the students to fill out their name and fake email. But the greatest
tool is the automatic approving of previously approved comments. This is where the fake
email comes in. Turning on the third option automates your moderating strategy.

Support
You can of course email me for additional support. The whole blogging community is a very
supportive group and help can be found in many forms. For specific help with Edublogs,
Visit http://edublogs.org for lots of help files, support links, and blog ideas.
This handout can be found online at http://classroomblogging.wordpress.com along with a
new post every month about how teachers can use blogging in their classroom.
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